Chapter 422

Two-Sample T-Tests Assuming Equal Variance (Enter Means)

Introduction

This procedure provides sample size and power calculations for one- or two-sided two-sample t-tests when the variances of the two groups (populations) are assumed to be equal. This is the traditional two-sample t-test (Fisher, 1925). There are two PASS procedures for two-sample t-tests assuming equal variance. In this procedure, the assumed difference between means is specified by entering the means for the two groups and letting the software calculate the difference. If you wish to enter the difference directly, you can use the Two-Sample T-Tests Assuming Equal Variance (Enter Difference) procedure.

The design corresponding to this test procedure is sometimes referred to as a parallel-groups design. This design is used in situations such as the comparison of the income level of two regions, the nitrogen content of two lakes, or the effectiveness of two drugs.

There are several statistical tests available for the comparison of the center of two populations. This procedure is specific to the two-sample t-test assuming equal variance. You can examine the sections below to identify whether the assumptions and test statistic you intend to use in your study match those of this procedure, or if one of the other PASS procedures may be more suited to your situation.

Other PASS Procedures for Comparing Two Means or Medians

Procedures in PASS are primarily built upon the testing methods, test statistic, and test assumptions that will be used when the analysis of the data is performed. You should check to identify that the test procedure described below in the Test Procedure section matches your intended procedure. If your assumptions or testing method are different, you may wish to use one of the other two-sample procedures available in PASS. These procedures are Two-Sample T-Tests Allowing Unequal Variance, Two-Sample Z-Tests Assuming Equal Variance, Two-Sample Z-Tests Allowing Unequal Variance, and the nonparametric Mann-Whitney-Wilcoxon (also known as the Mann-Whitney U or Wilcoxon rank-sum test) procedure. The methods, statistics, and assumptions for those procedures are described in the associated chapters.

If you wish to show that the mean of one population is larger (or smaller) than the mean of another population by a specified amount, you should use one of the clinical superiority procedures for comparing means. Non-inferiority, equivalence, and confidence interval procedures are also available.
Test Assumptions

When running a two-sample equal-variance t-test, the basic assumptions are that the distributions of the two populations are normal, and that the variances of the two distributions are the same. If those assumptions are not likely to be met, another testing procedure could be used, and the corresponding procedure in PASS should be used for sample size or power calculations.

Test Procedure

If we assume that \( \mu_1 \) and \( \mu_2 \) represent the means of the two populations of interest, the null hypothesis for comparing the two means is \( H_0 : \mu_1 = \mu_2 \). The alternative hypothesis can be any one of

\[
H_1 : \mu_1 \neq \mu_2 \\
H_1 : \mu_1 > \mu_2 \\
H_1 : \mu_1 < \mu_2
\]

depending upon the desire of the researcher or the protocol instructions. A suitable Type I error probability (\( \alpha \)) is chosen for the test, the data is collected, and a \( t \)-statistic is generated using the formula:

\[
t = \frac{\bar{x}_1 - \bar{x}_2}{\sqrt{\frac{(n_1 - 1)s_1^2 + (n_2 - 1)s_2^2}{n_1 + n_2 - 2}\left(\frac{1}{n_1} + \frac{1}{n_2}\right)}}
\]

This \( t \)-statistic follows a \( t \) distribution with \( n_1 + n_2 - 2 \) degrees of freedom. The null hypothesis is rejected in favor of the alternative if,

for \( H_1 : \mu_1 \neq \mu_2 \),

\[
t < t_{\alpha/2} \text{ or } t > t_{1-\alpha/2},
\]

for \( H_1 : \mu_1 > \mu_2 \),

\[
t > t_{1-\alpha},
\]

or, for \( H_1 : \mu_1 < \mu_2 \),

\[
t < t_{\alpha}.
\]

Comparing the \( t \)-statistic to the cut-off \( t \)-value (as shown here) is equivalent to comparing the \( p \)-value to \( \alpha \).
Power Calculation

This section describes the procedure for computing the power from \( n_1 \) and \( n_2 \), \( \alpha \), the assumed \( \mu_1 \) and \( \mu_2 \), and the assumed common standard deviation, \( \sigma_1 = \sigma_2 = \sigma \). Two good references for these methods are Julious (2010) and Chow, Shao, and Wang (2008).

The figure below gives a visual representation for the calculation of power for a one-sided test.

![Central t distribution and Non-central t distribution](image.png)

If we call the assumed difference between the means, \( \delta = \mu_1 - \mu_2 \), the steps for calculating the power are as follows:

1. Find \( t_{1-\alpha} \) based on the central-\( t \) distribution with degrees of freedom, \( df = n_1 + n_2 - 2 \).

2. Calculate the non-centrality parameter:
   \[
   \lambda = \frac{\delta}{\sigma \sqrt{\frac{1}{n_1} + \frac{1}{n_2}}}.
   \]

3. Calculate the power as the probability that the test statistic \( t \) is greater than \( t_{1-\alpha} \) under the non-central-\( t \) distribution with non-centrality parameter \( \lambda \):
   \[
   Power = \Pr_{Non-central-t}(t > t_{1-\alpha} \mid df = n_1 + n_2 - 2, \lambda).
   \]

The algorithms for calculating power for the opposite direction and the two-sided hypotheses are analogous to this method.

When solving for something other than power, PASS uses this same power calculation formulation, but performs a search to determine that parameter.

A Note on Specifying the Means

When means are specified in this procedure, they are used to determine the assumed difference in means for power or sample size calculations. It does not mean that the study will be powered to show that the mean difference is this amount, but rather that the design is powered to reject the null hypothesis of equal means if this were the true difference in means. If your purpose is to show that one mean is greater than another by a specific amount, you should use one of the clinical superiority procedures for comparing means.
A Note on Specifying the Standard Deviation

The sample size calculation for most statistical procedures is based on the choice of alpha, power, and an assumed difference in the primary parameters of interest – the difference in means in this procedure. An additional parameter that must be specified for means tests is the standard deviation. Here, we will briefly discuss some considerations for the choice of the standard deviation to enter.

If a number of previous studies of a similar nature are available, you can estimate the variance based on a weighted average of the variances, and then take the square root to give the projected standard deviation.

Perhaps more commonly, only a single pilot study is available, or it may be that no previous study is available. For both of these cases, the conservative approach is typically recommended. In PASS, there is a standard deviation estimator tool. This tool can be used to help select an appropriate value or range of values for the standard deviation.

If the standard deviation is not given directly from the previous study, it may be obtained from the standard error, percentiles, or the coefficient of variation. Once a standard deviation estimate is obtained, it may useful to then use the confidence limits tab to obtain a confidence interval for the standard deviation estimate. With regard to power and sample size, the upper confidence limit will then be a conservative estimate of the standard deviation. Or a range of values from the lower confidence limit to the upper confidence limit may be used to determine the effect of the standard deviation on the power or sample size requirement.

If there is no previous study available, a couple of rough estimation options can be considered. You may use the data tab of the standard deviation estimator to enter some values that represent typical values you expect to encounter. This tool will allow you to see the corresponding population or sample standard deviation. A second rough estimation technique is to base the estimate of the standard deviation on your estimate of the range of the population or the range of a data sample. A conservative divisor for the population range is 4. For example, if you are confident your population values range from 45 to 105, you would enter 60 for the Population Range, and, say, 4, for ‘C’. The resulting standard deviation estimate would be 15.

If you are unsure about the value you should enter for the standard deviation, we recommend that you additionally examine a range of standard deviation values to see the effect that your choice has on power or sample size.

Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are $\mu_1$, $\mu_2$, $\sigma$, $Alpha$, $Power$, and $Sample Size$. In most situations, you will likely select either $Power$ or $Sample Size$.

The ‘Solve For’ parameter is the parameter that will be displayed on the vertical axis of any plots that are shown.
Two-Sample T-Tests Assuming Equal Variance (Enter Means)

Test Direction

Alternative Hypothesis
Specify the alternative hypothesis of the test.
If you want to input differences rather than means, there is a similar procedure to this one where differences are entered rather than means.
The options with $\mu_1 < \mu_2$ and $\mu_1 > \mu_2$ are one-tailed tests. When you choose one of these, you should be sure that you enter $\mu_1$ and $\mu_2$ values that match this alternative hypothesis direction.

Power and Alpha

Power
Power is the probability of rejecting the null hypothesis when it is false. Power is equal to 1 - Beta, so specifying power implicitly specifies beta. Beta is the probability obtaining a false negative with the statistical test. That is, it is the probability of accepting a false null hypothesis.
The valid range is 0 to 1. Different disciplines have different standards for setting power. The most common choice is 0.90, but 0.80 is also popular.
You can enter a single value, such as 0.90, or a series of values, such as .70 .80 .90, or .70 to .90 by .1.
When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

Alpha
Alpha is the probability of obtaining a false positive with the statistical test. That is, it is the probability of rejecting a true null hypothesis. The null hypothesis is usually that the parameters of interest (means, proportions, etc.) are equal.
Since Alpha is a probability, it is bounded by 0 and 1. Commonly, it is between 0.001 and 0.10.
Alpha is often set to 0.05 for two-sided tests and to 0.025 for one-sided tests.
You can enter a single value, such as 0.05, or a series of values, such as .05 .10 .15, or .05 to .15 by .01.
When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

Sample Size (When Solving for Sample Size)

Group Allocation
Select the option that describes the constraints on $N_1$ or $N_2$ or both.
The options are

- **Equal ($N_1 = N_2$)**
  This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- **Enter $N_1$, solve for $N_2$**
  Select this option when you wish to fix $N_1$ at some value (or values), and then solve only for $N_2$. Please note that for some values of $N_1$, there may not be a value of $N_2$ that is large enough to obtain the desired power.

- **Enter $N_2$, solve for $N_1$**
  Select this option when you wish to fix $N_2$ at some value (or values), and then solve only for $N_1$. Please note that for some values of $N_2$, there may not be a value of $N_1$ that is large enough to obtain the desired power.
Two-Sample T-Tests Assuming Equal Variance (Enter Means)

- **Enter R = N2/N1, solve for N1 and N2**
  For this choice, you set a value for the ratio of \( N2 \) to \( N1 \), and then PASS determines the needed \( N1 \) and \( N2 \), with this ratio, to obtain the desired power. An equivalent representation of the ratio, \( R \), is
  \[
  N2 = R \times N1.
  \]

- **Enter percentage in Group 1, solve for N1 and N2**
  For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS determines the needed \( N1 \) and \( N2 \) with this percentage to obtain the desired power.

### N1 (Sample Size, Group 1)
*This option is displayed if Group Allocation = “Enter N1, solve for N2”*

\( N1 \) is the number of items or individuals sampled from the Group 1 population.

\( N1 \) must be \( \geq 2 \). You can enter a single value or a series of values.

### N2 (Sample Size, Group 2)
*This option is displayed if Group Allocation = “Enter N2, solve for N1”*

\( N2 \) is the number of items or individuals sampled from the Group 2 population.

\( N2 \) must be \( \geq 2 \). You can enter a single value or a series of values.

### R (Group Sample Size Ratio)
*This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”*

\( R \) is the ratio of \( N2 \) to \( N1 \). That is,

\[
R = \frac{N2}{N1}.
\]

Use this value to fix the ratio of \( N2 \) to \( N1 \) while solving for \( N1 \) and \( N2 \). Only sample size combinations with this ratio are considered.

\( N2 \) is related to \( N1 \) by the formula:

\[
N2 = \lceil R \times N1 \rceil,
\]

where the value \( \lceil Y \rceil \) is the next integer \( \geq Y \).

For example, setting \( R = 2.0 \) results in a Group 2 sample size that is double the sample size in Group 1 (e.g., \( N1 = 10 \) and \( N2 = 20 \), or \( N1 = 50 \) and \( N2 = 100 \)).

\( R \) must be greater than 0. If \( R < 1 \), then \( N2 \) will be less than \( N1 \); if \( R > 1 \), then \( N2 \) will be greater than \( N1 \). You can enter a single or a series of values.

### Percent in Group 1
*This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”*

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for \( N1 \) and \( N2 \). Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.
Sample Size (When Not Solving for Sample Size)

Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.

The options are

- **Equal (N1 = N2)**
  This selection is used when you wish to have equal sample sizes in each group. A single per group sample size will be entered.

- **Enter N1 and N2 individually**
  This choice permits you to enter different values for N1 and N2.

- **Enter N1 and R, where N2 = R * N1**
  Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

- **Enter total sample size and percentage in Group 1**
  Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N, and then N2 as N - N1.

Sample Size Per Group
*This option is displayed only if Group Allocation = “Equal (N1 = N2).”*

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value for N2.

The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.

**N1 (Sample Size, Group 1)**
*This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 = R * N1.”*

N1 is the number of items or individuals sampled from the Group 1 population.

N1 must be ≥ 2. You can enter a single value or a series of values.

**N2 (Sample Size, Group 2)**
*This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”*

N2 is the number of items or individuals sampled from the Group 2 population.

N2 must be ≥ 2. You can enter a single value or a series of values.
Two-Sample T-Tests Assuming Equal Variance (Enter Means)

**R (Group Sample Size Ratio)**

*This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”*

R is the ratio of N2 to N1. That is,

\[ R = \frac{N2}{N1} \]

Use this value to obtain N2 as a multiple (or proportion) of N1.

N2 is calculated from N1 using the formula:

\[ N2 = \lceil R \times N1 \rceil \]

where the value \( \lceil Y \rceil \) is the next integer ≥ Y.

For example, setting \( R = 2.0 \) results in a Group 2 sample size that is double the sample size in Group 1.

R must be greater than 0. If \( R < 1 \), then N2 will be less than N1; if \( R > 1 \), then N2 will be greater than N1. You can enter a single value or a series of values.

**Total Sample Size (N)**

*This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”*

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of the total sample size in Group 1, implicitly defines N1 and N2.

The total sample size must be greater than one, but practically, must be greater than 3, since each group sample size needs to be at least 2.

You can enter a single value or a series of values.

**Percent in Group 1**

*This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”*

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.

**Means**

**\( \mu_1 \) (Mean of Group 1)**

Enter a value for the assumed mean of Group 1. The calculations of this procedure are based on difference between the two means, \( \mu_1 - \mu_2 \). This difference is the difference at which the design is powered to reject equal means. If you want to input differences rather than means, there is a similar procedure to this one where differences are entered rather than means.

\( \mu_1 \) can be any value (positive, negative, or zero), but it should be consistent with the choice of the alternative hypothesis.

You can enter a single value, such as 10, or a series of values, such as 10  20  30, or 5 to 50 by 5.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.
**μ₂ (Mean of Group 2)**
Enter a value for the assumed mean of Group 2. The calculations of this procedure are based on difference between the two means, \( \mu_1 - \mu_2 \). This difference is the difference at which the design is powered to reject equal means. If you want to input differences rather than means, there is a similar procedure to this one where differences are entered rather than means.

\( \mu_2 \) can be any value (positive, negative, or zero), but it should be consistent with the choice of the alternative hypothesis.

You can enter a single value, such as 10, or a series of values, such as 10 20 30, or 5 to 50 by 5.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

**Standard Deviation**

**σ (Standard Deviation)**
The standard deviation entered here is the assumed standard deviation for both the Group 1 population and the Group 2 population.

σ must be a positive number.

You can enter a single value, such as 5, or a series of values, such as 1 3 5 7 9, or 1 to 10 by 1.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

Press the small 'σ' button to the right to obtain calculation options for estimating the standard deviation.
Example 1 – Finding the Sample Size

Researchers wish to compare two types of local anesthesia to determine whether there is a difference in time to loss of pain. Subjects will be randomized to treatment, the treatment will be administered, and the time to loss of pain measured. The anticipated time to loss of pain for one of the types of anesthesia is 9 minutes. The researchers would like to generate a sample size for the study with 90% power to reject the null hypothesis of equal loss-of-pain time if the true difference is at least 2 minutes. How many participants are needed to achieve 90% power at significance levels of 0.01 and 0.05?

Past experiments of this type have had standard deviations in the range of 1 to 5 minutes. It is anticipated that the standard deviation of the two groups will be equal.

It is unknown which treatment has lower time to loss of pain, so a two-sided test will be used.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample T-Tests Assuming Equal Variance (Enter Means) procedure window by expanding Means, then Two Independent Means, then clicking on Test (Inequality), and then clicking on Two-Sample T-Tests Assuming Equal Variance (Enter Means). You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Ha: $\mu_1 \neq \mu_2$</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.01 0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>$\mu_1$</td>
<td>9</td>
</tr>
<tr>
<td>$\mu_2$</td>
<td>11 (or 7 could equally be used)</td>
</tr>
<tr>
<td>$\sigma$</td>
<td>1 to 5 by 1</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Target Power</th>
<th>Actual Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>$\mu_1$</th>
<th>$\mu_2$</th>
<th>$\mu_1 - \mu_2$</th>
<th>$\sigma$</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90</td>
<td>0.92949</td>
<td>10</td>
<td>10</td>
<td>20</td>
<td>9.0</td>
<td>11.0</td>
<td>-2.0</td>
<td>1.0</td>
<td>0.01</td>
</tr>
<tr>
<td>0.90</td>
<td>0.92907</td>
<td>7</td>
<td>7</td>
<td>14</td>
<td>9.0</td>
<td>11.0</td>
<td>-2.0</td>
<td>1.0</td>
<td>0.05</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90906</td>
<td>32</td>
<td>32</td>
<td>64</td>
<td>9.0</td>
<td>11.0</td>
<td>-2.0</td>
<td>2.0</td>
<td>0.01</td>
</tr>
<tr>
<td>0.90</td>
<td>0.91250</td>
<td>23</td>
<td>23</td>
<td>46</td>
<td>9.0</td>
<td>11.0</td>
<td>-2.0</td>
<td>2.0</td>
<td>0.05</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90182</td>
<td>69</td>
<td>69</td>
<td>138</td>
<td>9.0</td>
<td>11.0</td>
<td>-2.0</td>
<td>3.0</td>
<td>0.01</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90434</td>
<td>49</td>
<td>49</td>
<td>98</td>
<td>9.0</td>
<td>11.0</td>
<td>-2.0</td>
<td>3.0</td>
<td>0.05</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90083</td>
<td>121</td>
<td>121</td>
<td>242</td>
<td>9.0</td>
<td>11.0</td>
<td>-2.0</td>
<td>4.0</td>
<td>0.01</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90323</td>
<td>86</td>
<td>86</td>
<td>172</td>
<td>9.0</td>
<td>11.0</td>
<td>-2.0</td>
<td>4.0</td>
<td>0.05</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90062</td>
<td>188</td>
<td>188</td>
<td>376</td>
<td>9.0</td>
<td>11.0</td>
<td>-2.0</td>
<td>5.0</td>
<td>0.01</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90148</td>
<td>133</td>
<td>133</td>
<td>266</td>
<td>9.0</td>
<td>11.0</td>
<td>-2.0</td>
<td>5.0</td>
<td>0.05</td>
</tr>
</tbody>
</table>
References
Chapman & Hall/CRC. Boca Raton, FL.

Report Definitions
Target Power is the desired power value (or values) entered in the procedure. Power is the probability of rejecting a false null hypothesis.
Actual Power is the power obtained in this scenario. Because N1 and N2 are discrete, this value is often (slightly) larger than the target power.
N1 and N2 are the number of items sampled from each population.
N is the total sample size, N1 + N2.
μ1 and μ2 are the assumed population means for power and sample size calculations.
μ1 - μ2 is the difference between population means at which power and sample size calculations are made.
σ is the assumed population standard deviation for each of the two groups.
Alpha is the probability of rejecting a true null hypothesis.

Summary Statements
Group sample sizes of 10 and 10 achieve 92.949% power to reject the null hypothesis of equal means when the population mean difference is μ1 - μ2 = 9.0 - 11.0 = -2.0 with a standard deviation for both groups of 1.0 and with a significance level (alpha) of 0.010 using a two-sided two-sample equal-variance t-test.

These reports show the values of each of the parameters, one scenario per row.

Plots Section
These plots show the relationship between the standard deviation and sample size for the two alpha levels.
Example 2 – Finding the Power

Suppose a new corn fertilizer is to be compared to a current fertilizer. The current fertilizer produces an average of about 74 lbs. per plot. The researchers need only show that there is difference in yield with the new fertilizer. They would like to consider the effect of the number of plots used on the power of the test if the improvement in yield is at least 10 lbs.

Researchers plan to use a one-sided two-sample t-test with alpha equal to 0.05. Previous studies indicate the standard deviation for plot yield to be between 20 and 30 lbs. The plot group sizes of interest are 10 to 100 plots per group.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample T-Tests Assuming Equal Variance (Enter Means) procedure window by expanding Means, then Two Independent Means, then clicking on Test (Inequality), and then clicking on Two-Sample T-Tests Assuming Equal Variance (Enter Means). You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

Option Value
Design Tab
Solve For ............................................. Power
Alternative Hypothesis ............................... Ha: \( \mu_1 < \mu_2 \)
Alpha .......................................................... 0.05
Group Allocation .................................. Equal (N1 = N2)
Sample Size Per Group .......................... 10 to 100 by 10
\( \mu_1 \) ........................................................... 74
\( \mu_2 \) ........................................................... 84
\( \sigma \) .......................................................... 20 25 30

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>( \mu_1 )</th>
<th>( \mu_2 )</th>
<th>( \mu_1 - \mu_2 )</th>
<th>( \sigma )</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.28476</td>
<td>10</td>
<td>10</td>
<td>20</td>
<td>74.0</td>
<td>84.0</td>
<td>-10.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.46337</td>
<td>20</td>
<td>20</td>
<td>40</td>
<td>74.0</td>
<td>84.0</td>
<td>-10.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.60603</td>
<td>30</td>
<td>30</td>
<td>60</td>
<td>74.0</td>
<td>84.0</td>
<td>-10.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.71625</td>
<td>40</td>
<td>40</td>
<td>80</td>
<td>74.0</td>
<td>84.0</td>
<td>-10.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.79984</td>
<td>50</td>
<td>50</td>
<td>100</td>
<td>74.0</td>
<td>84.0</td>
<td>-10.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.85948</td>
<td>60</td>
<td>60</td>
<td>120</td>
<td>74.0</td>
<td>84.0</td>
<td>-10.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.90297</td>
<td>70</td>
<td>70</td>
<td>140</td>
<td>74.0</td>
<td>84.0</td>
<td>-10.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.93369</td>
<td>80</td>
<td>80</td>
<td>160</td>
<td>74.0</td>
<td>84.0</td>
<td>-10.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.95510</td>
<td>90</td>
<td>90</td>
<td>180</td>
<td>74.0</td>
<td>84.0</td>
<td>-10.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.96985</td>
<td>100</td>
<td>100</td>
<td>200</td>
<td>74.0</td>
<td>84.0</td>
<td>-10.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.97091</td>
<td>10</td>
<td>10</td>
<td>20</td>
<td>74.0</td>
<td>84.0</td>
<td>-10.0</td>
<td>25.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.34367</td>
<td>20</td>
<td>20</td>
<td>40</td>
<td>74.0</td>
<td>84.0</td>
<td>-10.0</td>
<td>25.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.45471</td>
<td>30</td>
<td>30</td>
<td>60</td>
<td>74.0</td>
<td>84.0</td>
<td>-10.0</td>
<td>25.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.55111</td>
<td>40</td>
<td>40</td>
<td>80</td>
<td>74.0</td>
<td>84.0</td>
<td>-10.0</td>
<td>25.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.63357</td>
<td>50</td>
<td>50</td>
<td>100</td>
<td>74.0</td>
<td>84.0</td>
<td>-10.0</td>
<td>25.0</td>
<td>0.050</td>
</tr>
</tbody>
</table>
These reports show the values of each of the parameters, one scenario per row.

**Plots Section**

These plots show the relationship between the power and sample size for the three values of $\sigma$.
Example 3 – Finding the Difference

In some cases it may be useful to determine how different the means of two populations would need to be to achieve the desired power with a specific constrained sample size.

Suppose, for example, that 80 subjects are available for a study to compare weight loss regimens. Researchers would like to determine which of the two regimens is better. The anticipated weight loss after two months is anticipated to be about 20 lbs. The researchers would like to know how different the mean weight loss must be to have a study with 90% power when alpha is 0.05 and the standard deviation is assumed to be 7 lbs. in both groups.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample T-Tests Assuming Equal Variance (Enter Means) procedure window by expanding Means, then Two Independent Means, then clicking on Test (Inequality), and then clicking on Two-Sample T-Tests Assuming Equal Variance (Enter Means). You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>( \mu_2 )</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>( H_a: \mu_1 \neq \mu_2 )</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (( N_1 = N_2 ))</td>
</tr>
<tr>
<td>Sample Size Per Group</td>
<td>40</td>
</tr>
<tr>
<td>( \mu_1 )</td>
<td>20</td>
</tr>
<tr>
<td>( \mu_2 )</td>
<td>Search &gt; ( \mu_1 )</td>
</tr>
<tr>
<td>( \sigma )</td>
<td>7</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Numeric Results for Two-Sample T-Test Assuming Equal Variance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alternative Hypothesis: ( \mu_1 \neq \mu_2 )</td>
</tr>
</tbody>
</table>
| \hline
<table>
<thead>
<tr>
<th>Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>( \mu_1 )</th>
<th>( \mu_2 )</th>
<th>( \mu_1 - \mu_2 )</th>
<th>( \sigma )</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90000</td>
<td>40</td>
<td>40</td>
<td>80</td>
<td>20.000</td>
<td>25.137</td>
<td>-5.137</td>
<td>7.0</td>
<td>0.050</td>
</tr>
</tbody>
</table>

If the true population mean weight loss for one group is 5.137 lbs. more or less than the other, the researchers would have 90% power to show a difference between the groups.
Example 4 – Validation of Sample Size using Machin et al.

Machin et al. (1997) page 35 present an example for a two-sided test in which the mean difference is 5, the common standard deviation is 10, the power is 90%, and the significance level is 0.05. They calculate the per group sample size as 86.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample T-Tests Assuming Equal Variance (Enter Means) procedure window by expanding Means, then Two Independent Means, then clicking on Test (Inequality), and then clicking on Two-Sample T-Tests Assuming Equal Variance (Enter Means). You may then make the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Ha: μ1 ≠ μ2</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>μ1</td>
<td>0</td>
</tr>
<tr>
<td>μ2</td>
<td>5</td>
</tr>
<tr>
<td>σ</td>
<td>10</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Target Power</th>
<th>Actual Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>μ1</th>
<th>μ2</th>
<th>μ1 - μ2</th>
<th>σ</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90</td>
<td>0.90323</td>
<td>86</td>
<td>86</td>
<td>172</td>
<td>0.0</td>
<td>5.0</td>
<td>-5.0</td>
<td>10.0</td>
<td>0.050</td>
</tr>
</tbody>
</table>

The sample size of 86 per group matches Machin’s result exactly.
Example 5 – Validation using Zar

Zar (1984) page 136 give an example in which the mean difference is 1, the common standard deviation is 0.7206, the sample sizes are 15 in each group, and the significance level is 0.05. They calculate the power as 0.96.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample T-Tests Assuming Equal Variance (Enter Means) procedure window by expanding Means, then Two Independent Means, then clicking on Test (Inequality), and then clicking on Two-Sample T-Tests Assuming Equal Variance (Enter Means). You may then make the appropriate entries as listed below, or open Example 5 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Ha: ( \mu_1 \neq \mu_2 )</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Sample Size Per Group</td>
<td>15</td>
</tr>
<tr>
<td>( \mu_1 )</td>
<td>0</td>
</tr>
<tr>
<td>( \mu_2 )</td>
<td>1</td>
</tr>
<tr>
<td>( \sigma )</td>
<td>0.7206</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Numeric Results for Two-Sample T-Test Assuming Equal Variance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alternative Hypothesis: ( \mu_1 \neq \mu_2 )</td>
</tr>
<tr>
<td>Power</td>
</tr>
<tr>
<td>0.95611</td>
</tr>
</tbody>
</table>

The power of 0.95611 matches Zar’s result of 0.96 to the two decimal places given.
Example 6 – Validation using Julious

Julious (2010) page 49, as part of a table, gives an example in which the mean difference is 0.05, the common standard deviation is 1, the power is 90%, and the significance level is 0.05. He calculates the sample size for each group to be 8,407.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample T-Tests Assuming Equal Variance (Enter Means) procedure window by expanding Means, then Two Independent Means, then clicking on Test (Inequality), and then clicking on Two-Sample T-Tests Assuming Equal Variance (Enter Means). You may then make the appropriate entries as listed below, or open Example 6 by going to the File menu and choosing Open Example Template.

Option | Value
--- | ---
**Design Tab**
Solve For | Sample Size
Alternative Hypothesis | Ha: μ₁ ≠ μ₂
Power | 0.90
Alpha | 0.05
Group Allocation | Equal (N₁ = N₂)
μ₁ | 0
μ₂ | 0.05
σ | 1

Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Target Power</th>
<th>Actual Power</th>
<th>N₁</th>
<th>N₂</th>
<th>N</th>
<th>μ₁</th>
<th>μ₂</th>
<th>μ₁ - μ₂</th>
<th>σ</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90</td>
<td>0.90003</td>
<td>8407</td>
<td>8407</td>
<td>16814</td>
<td>0.0</td>
<td>0.1</td>
<td>-0.1</td>
<td>1.0</td>
<td>0.050</td>
</tr>
</tbody>
</table>

The sample size matches Julious’ result of 8,407 exactly.